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TZAR Editor Manual

Please open the TZAR folder on your hard drive, and double-click on tzaredit.exe. The Map 
Editor lets you create, or modify, maps for the game TZAR. You can create maps of different 
sizes for up to eight players. You can also create map rules that will change player behavior or 
disturb the player when he or she uses the custom map. In addition, you may create conversations 
to make the map more appealing and realistic. Add your own images, sound and music in order to 
create a unique and customized map. 

1. General User Interface
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1.1.Toolbar

To display or hide the Tool Bar, use the Tool Bar command in the View menu. The main Tool 
Bar contains short cuts to frequently used commands. The Tool Bar button commands are as 
follows:
� Create a new map, Open an existing map, Save the active map
� Select objects, Delete selected objects, Edit selected object properties 
� Activate the workspace window, Activate the mini-map window, Activate the Object 

Locator window

1.2.Players’ Bar

To display or hide the Players’ Bar, use the Players’ Bar command in the View menu. The 
Players’ Bar is displayed when placing and editing map objects. It contains ten color boxes. The 
first eight buttons indicates the players’ color. The next two boxes open the Rescue and the
Nature units. Select a unit, then choose its player’s color or kingdom. You can change the color 
of each kingdom by dragging the object or selected objects.

1.3. Brushes Bar

To display or hide the Brushes Bar, use the Brushes Bar command in the View menu. The 
Brushes Bar is displayed when drawing terrain or placing/deleting trees.
You can choose between six different sizes of brushes to paint with. The smallest brush is used to 
create precise details on the terrain. Five different brushes are available for placing/deleting trees.

1.4. Status Bar
To display or hide the Status Bar, use the Status Bar command in the View menu. 
The Status Bar is found at the bottom of the main window. Two cells containing context sensitive 
information are located to the right. Cell 1 tells you the name of the currently selected player. Cell 
2 gives the current cursor position in the map.

1.5. Workspace
To display or hide the Workspace Bar, use the Workspace command in the View menu. The 
Workspace Bar may be docked on the left-hand side or the right–hand side of the application. It 
can also be left floating anywhere on the screen. The Workspace Bar contains four main 
directories: Terrain, Buildings, Units and Items. The tabs, placed at the bottom of the workspace, 
activate each one of these directories. This is the menu where all map terrain and objects are 
listed.
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Note: The Workspace Bar can be docked on the left-hand side or the right-hand side of the main 
window. You can resize the Workspace when it is docked and/or floating.

1.6. Mini-Map
To display or hide the Mini-map, use the Mini-Map command in the View menu.

The Mini-Map provides a small view of the entire map. Inside the mini-map is a small rectangle. 
This rectangle shows the area currently on display in the main window.
By clicking on a location in the Mini-Map, your main window view will jump to the desired
location. You may also click and drag this view to scan the map.

1.7. Navigating the Map
The main window shows only a portion of the entire map. To view other areas, use the arrow
keys on the keyboard or the scrollbars in the main window. You may also click and drag the
Mini-Map to rapidly scroll your view. 

2. Creating a New Map

Select New in the File menu, you will then see the New Map dialog. 
There are two types of new maps. You can create an empty map (the landscape derives from one 
terrain only) and a random map (the landscape derives from different kinds of terrain combined in 
different shapes). To switch between these two new map types, use the Empty and the Random
radio buttons. 

Choose which combination of terrain you want to use with the drop list Terrain Set. Use the 
drop list Size to select the dimensions for your map. There are seven different map sizes: Tiny
(64x64), Small (96x96), Medium (128x28), Large (192x192), Huge (256x256), Enormous
(384x384) and Real World (512x512).
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Note: The map dimensions and the terrain set cannot be changed without creating a new map.

When you create an empty map, it will be filled with the selected terrain type in the Start
Terrain drop list. Check Patches to generate ground patches in the empty map. To generate 
ground objects in the empty map, check Rocks. To generate animals in the empty map, check 
Animals.

Use the Type drop list to create a random map with a certain landscape type. Set the number of 
players in the random map by using the Players’ spin control. Use the Advanced button for 
detailed players’ setting. This button will activate the Random Map Players’ dialog. In this 
dialog box you may edit the name of the Kingdom, the TZAR name, and change civilization. 
(When you select Random, the civilization will be randomly generated.) Note that the checked 
players have to be equal to the number of players.
To generate ground patches in the map, check Patches. To generate ground objects, check
Rocks. Check Cliffs to generate cliffs and check Rivers to generate rivers in the map. To 
generate trees, check Trees. Check Animals to generate animals. To generate towers in the map, 
check Towers. Check Magic Gateways to generate magic gateways, and check Items to
generate items in the map. With the Resources radio buttons, you decide how many resources 
you would like to generate.

3. Loading an Existing Map

A standard Windows dialog box for opening files, in this case TZAR maps, is opened by 
selecting Open from the File menu or by pressing Control-O.

The Open dialog box initially lists map files from the Map directory within your TZAR game 
directory. (TZAR map files have a file extension of  .wmp; for example, ‘MyMap.wmp’). If the 
map you wish to open is not located there, simply navigate your way to the directory containing 
the map file, just as you would from any standard Windows Open dialog box.

Once you have located the map file you wish to edit, click on its name to open it. If you were in 
the process of editing another map, you will be given the option to save that map before opening 
the new one. You may also click on the Cancel button if you change your mind about loading a 
new map.

4. Saving a Map

If you are working on a new map, selecting the command Save from the File menu or pressing 
Control-S, opens a standard Windows dialog box for saving files. 

The default name for a new map file is ‘Untitled.wmp’, but you may change the name to a more 
descriptive one. We strongly recommend you to keep the file name extension as “wmp”, so that 
you can readily identify it as a TZAR map file.
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The default directory for a new map is the Map directory within your TZAR game directory.
However, you may change the directory simply by navigating to a new location, just as you 
would when saving any other Windows file.

Note: If you want to play your map as a custom map you have to save (place) it in your 
TZAR\MAPS folder.

If you decide to edit the map again at a later date and save it again, the TZAR Editor will 
automatically save the edited map in its original location without opening the Save dialog 
window. To save an edited map in a different location or under a new name, choose the Save As
option from the File menu instead.

Note: When you save the game, the editor checks your map for possible errors or missing items. 
If any errors are found, a list of these errors will appear. The map will be saved, but you will not 
be able to play it, since the game might be unstable. So, when you finish your map, make sure 
that it doesn’t contain any errors before saving it.

5. Edit Terrain

All commands for editing terrain are situated in the Terrain tab in the Workspace Bar. Click on 
this tab and select the desired command.

5.1. Painting Landscapes
In the main window, you can click to place an individual terrain in the map, or click and drag to 
fill in large areas with the currently selected terrain type. If you click and drag the brush to the 
edge of the main window, the view will scroll in the direction of the brush, while continuing to 
paint.
When you paint, or drag the brush, you will see that the brush turns red in certain areas. This 
means that it is not possible to place terrain from the currently selected type in the areas in 
question.

If you select cliffs, you will be able to paint elevations. Just click at the starting point you choose 
and begin to drag the cursor. The cliff will be placed only on terrain that allows cliffs.  Nothing 
will happen in the wrong type of terrain. Cliffs will be removed when you place terrain over 
them, so if you want to clear some cliffs just cover them with terrain.

You can select different brush sizes from the Brushes toolbar.

5.2. Placing Trees
You can place trees on the map. There are different tree types, depending on the map terrain 

set. You can use different brushes when placing trees. The number of trees that will be placed in 
the brush square will depend on the forest density. To choose a different forest density, use the 
commands in the Edit/Forest Density menu.

You may also accumulate trees in one brush location if you are in the Forest Accumulation 
mode. To enter or leave this mode, use the command in the Edit/Forest Accumulation menu.
� To place a specific tree of a certain type, use the command Trees/<type>/<specific tree>, 

then click and drag to paint.
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� To place random trees of one type, use the command Trees/<type> to select the tree type, 
then click and drag to paint.

� To place random trees of all types, use the command Trees, then click and drag to paint.
� To delete trees, use the command Trees/Delete Trees, then click and drag the brush.

5.3. Placing Ground Patches
Ground patches are terrain decorations such as small stones, branches, spots or pieces of 

trash. These objects make your map look more realistic. 
� Ground patches can be placed anywhere on the terrain, but only if colored in green. 
� You may place ground patches beneath other objects or units, or on top of already placed 

ground patches.
� You can place random ground patches when a group is selected. For example, select the 

Ground patches/Trash group or the Ground patches/Stone group and then start placing 
them. Different types of trash or stones will appear every time the mouse is clicked. 

� You can scroll random ground patches with the TAB key while dragging them.

6. Map Objects

Map objects are Buildings, Units, Items, Ground and Water objects, Special locations and 
Resources. Ground and Water objects, Special locations and Resources are situated in the 
Workspace Terrain tab. Buildings are found in the Workspace Buildings tab. Units are found in 
the Workspace Units tab, and Items are situated in the Workspace Items tab.

6.1. Placing Objects In the Map
To place a certain object, select it from the proper workspace, then drag it and click on the 
main window view. When you drag the object, its color will be a shade of red or green. If the 
object is green, the terrain beneath it is suitable for this object. If the object is red, the terrain 
beneath it is unsuitable for this object. Units can only be placed if they are on suitable terrain.

You may change the current kingdom by selecting kingdom color in the Players’ Bar. All 
units and buildings will belong to the selected kingdom.

6.2. Moving Objects
Enter the select mode to move objects that are already present in the map. Then make a 
selection, and click on one of the selected objects while holding down the Alt key and 
dragging your selection to a new map location.

6.3. Moving a Copy of a Selected Object
To move copies of selected objects to a new map location, click on one of the selected objects 
while holding down the Ctrl key and dragging the copy of your selection to a new map 
location.

6.4 Deleting Objects
Make a selection in the select mode. Then use the Delete Selection command in the Edit
menu.

6.5. Ground Objects
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There are different groups of ground objects depending on the map terrain set. Ground objects 
are found in the workspace Terrain tab. 

Ground patches are different terrain decorations such as small stones, branches, spots or 
pieces of trash. These small objects will give your map a more realistic look. 

You can place random ground objects when a group is selected. For example: Select the 
Ground Objects/Ruins or the Ground Objects/Skeleton group and then start placing them.
Different types of ruins or skeletons will appear every time the mouse is clicked. You may scroll 
random ground objects with the TAB key while dragging them.

� Ground Objects can only be placed on land (ground) terrain.
� To place a specific type of ground object, enter one of the categories and select the desired 

object.
� You can place random ground objects when a group is selected. For example: Select the 

Ruins or the Skeleton group and then drag and click to place. Different ruins or skeletons 
will appear every time the mouse is clicked.

� You can scroll these random shapes with the TAB key while dragging them.

6.6. Water Objects
Water objects are similar to ground objects except that they can only be placed in water 
terrain.

6.7. Special Locations
Special Locations are found in the Workspace Terrain tab. 
� Random special locations can be placed when a group has been selected. When you select 

Special Locations, different types will appear every time the mouse is clicked.
� You can scroll random special locations with the TAB key while dragging them.

6.8. Resources
Resources are found in the Workspace Terrain tab. You place random resources in the same 
manner as with the ground objects, and scroll between different shapes with the TAB key.
Open the Object Properties dialog to change the amount of the selected resource/s/. Type a 
custom amount or restore the default settings. The amount of multiple resources can also be 
changed in the Object Properties dialog. The amount you enter will be the amount of each of 
the selected resources.
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6.9. Buildings
Buildings are found in the Workspace Building tab. There are four main categories. The first 
three contains buildings that are unique for the each civilization - European, Asian and 
Arabian. The fourth category contains buildings that are common for all races. 

Note: Harbors can only be placed on coasts.

There are some special actions on placing walls, gates and bridges.
• Walls – to place walls, click on the main window and drag the wall while holding the 

mouse button down. If you click and drag the wall to the edge of the main window, the 
view will scroll in the direction of the wall, while continuing to place walls.

• Gates – to change between horizontal and vertical gates, hold the Ctrl key. To change 
between left/right for a vertical gate and up/down for a horizontal gate, hold the Alt key. 
By holding both the Ctrl and the Alt keys a vertical wall will be opened. 

• Bridges – to change between horizontal and vertical bridges, hold the Alt key.

Open the Object Properties dialog to change building properties. There are two groups with 
building properties.
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General Building properties

� Kingdom drop list box – changes the kingdom of the building.
� Name edit box – changes the name of the building displayed in the game.
� Title edit box - changes the title of the building in the game. A title is somewhat like a 

second name.
� Default – restores default values for name and title.
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Building Skills properties

� Health - the amount of damage a building will withstand when attacked.
� Max Health – the maximum health potential a building can have.
� Resistance – how the building will withstand capture.

Note: When the check box to the left of the property is unchecked, the default settings are 
used for this property when playing the map. 

� Not Appear - when checked, the building will appear in the game after a corresponding 
Appear Object Action is started.

6.10. Units
Units are in found in the Workspace Units tab. There are five main categories. The first three 
contains units that are unique for the different civilizations - European, Asian and Arabian. 
The fourth category contains units common for all races. The last category contains animals 
and other creatures. All units from this group are Nature units by default. Some units can only 
be placed on ground terrain (peasants, archers), others only in water terrain (hulks, galleons), 
or in the air (dragons, flying carpets). You cannot place one unit on top of another if they are 
on the same layer (ground, water or air). For example: You can place a dragon on top of a 
castle, but you cannot place a dragon on top of a flying carpet.
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While dragging the unit, you can rotate it with the TAB key (clockwise), or with Shift + TAB
(contra clockwise).

Every unit in the map can be customized by using the Object Properties dialog. There are 
three groups of unit properties.

General unit properties 

� Kingdom drop list – changes the kingdom of the unit/s/.
� Name edit box – changes the name of the unit. This property is available only in the 

single selection.
� Title edit box – changes the title of the unit. A title is somewhat like a second name. This 

property is available only in the single selection.
� Default – restores the default values for name and title.
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Icon properties

� Pick Icon and Big Icon. The Pick button launches the Import Images dialog. The 
preferable picture size is 44/44 pixels for Icons and 96/96 pixels for Big Icons.

� View – displays the selected picture for Icon and Big Icon.
� Default – restores the default values.
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Unit Skill properties

� Health - the amount of damage a unit will withstand when attacked.
� Max Health – the maximum health potential a unit can have.
� Attack – the amount of damage a unit can cause when attacking another object.
� Manna – the current magic capacity of a unit.
� Defense – to what degree the extent of damage is reduced when a unit is attacked.
� Level – the experience of the unit.

Note: When the check box to the left of the property is unchecked, the default settings are 
used for this property when playing the map. 

Flags:
� No AI – when checked, the unit is under AI control.
� Persistent – when checked, the unit properties are saved at the end of each campaign 

map, if the unit is still alive. When the game encounters a unit with the same name in one 
of the following campaign maps, it will assign the same values for properties as the unit 
with a persistent flag.

� Not Appear - when checked, the unit will appear in the game after a corresponding 
Appear Object Action is started.

� Default – restores the default values.
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When editing multiple unit properties, each value will apply to all unit properties. 

6.11. Items 
Items are found in the Workspace Items tab. There are six item types. Items don’t belong to 
any specific kingdom.
� To place a specific type of item, enter one of the categories and select the desired item 

image.
� A random type of item can be placed when a group has been selected. For example: Select 

the Armors group, then drag and click it to place. Different armors will appear every time 
the mouse is clicked.

� You can scroll these random item shapes with the TAB key while dragging the item.

Open the Object Properties dialog to change item properties. There are General item 
properties groups for all item types and one additional group of properties for every item type.

General Item properties

� Name edit box – changes the name of the item.
� Title edit box – changes the title of the item. A title is somewhat like a second name.
� Not Appear - when checked, the item will appear in the game after a corresponding

Appear Object Action is started.
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� Not Appear – when checked, the item is not displayed in the game until the Appear
Object Action is started.

� Default – restores the default settings.

6.11.1. Resource Item - when a unit picks this item, the player’s corresponding resource will 
increase with the amount of this item.

Amount properties – enters the amount of a resource item in the edit box.

6.11.2. Armor Item – when a unit picks this item, the Defense property will change the
Skills properties 

� Defense – indicates how much the defense parameter changes for the owner of the item.
� Default – restores the default value.
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6.11.3. Weapon Item – when a unit picks this item, the Attack property will change with a 
specified value. When a unit drops the item, its Attack property is restored to its previous value.

Additional properties 

� Attack – indicates how much the attack parameter changes for the owner of the item.
� Default – restores the default settings (defense is changed to 50).
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6.11.4. Scroll Items – when a unit pick this item, the player will see a text scrolled over the 
image, hear sound and music. 

Text property 

� Text box – type text used in the game story. This text appears when you pick the item.
� Scroll time – the amount of time which the text scrolls.
� Auto close -  if checked, the text window will close automatically after the text was 

scrolled.
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6.11.5. Image & Sound & Music property

� Pick Image, Sound or Music. The Pick button launches the Import Images, the Import 
Sounds, the Import Music dialog, and the User Resources/ [img.14e]. The best image 
size is 295/390 pixels high color.

� View button – click to view the assigned image.
� Play button - click to play sound or music.
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6.11.6. Spell Book Item – when a unit picks this item, it will learn to use spells (magic).
Magic property

� Magic Type – changes the spell (magic) kept in this book.
� Needs manna to use – if checked, the unit needs manna to use the spell.
� Time restriction – the minimum time between subsequent spell (magic) usage.
� Max charges – the maximum number of times a spell (magic) can be used.
� Default – restores the default values.
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6.11.7. Potion Items – when a unit picks this item, some of its properties will change.
Additional properties

� Level – a certain amount of experience will be added to the unit’s Level property.
� Attack – a certain amount of attack will be added to the unit’s Attack property.
� Defense – a certain amount of defense will be added to the unit’s Defense property.
� Health – a certain amount of health will be added to the unit’s Health property.
� Manna/Power – a certain amount of manna will be added to the unit’s Manna/Power

property.
� Default – restores the default values.
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6.12. Object Locator
The Object Locator helps you to quickly find objects using a type filter, a player/kingdom 
filter or a named filter. You can browse the objects in the map using these filters, view objects 
in the main window (scrolls view to center object in the main window), edit properties or 
delete objects.
To show the Object Locator, use the command in the View/Object Locator menu.

� Type Filter – selects the type of objects to locate: Resources, special locations, buildings, 
units or items.

� Objects – in this list box, you find all objects that correspond to the selected filter
requirements.

� Player Filter – this filter is available only for special locations, building or units type
filter. Check the number of player/kingdom whose special locations/buildings/units you 
want to operate.

� Named – check this if you wish to operate with named objects only. 
� Properties button – launches the Object Properties dialog for the selected object.
� View button – click this button to center the selected object in the main window.
� Delete button – deletes the selected object from the map.
� Close – closes the Object Locator.

7. Starting locations



22

To edit starting locations for each player, use the command Starting location in the Edit
menu. Each player in the map requires a starting location. For human players, starting 
locations determine where the player’s screen will be centered when the mission starts. 
Click on the main window to place the starting location for the current player. Change the 
current player/kingdom in the Players’ Bar or use shortcuts (number keys 1 to 8).

8. Map Properties 

To edit map properties, use the command Properties in the Map menu and open the Map
Properties dialog. This dialog contains three groups of map properties.

8.1. General Map Properties

� Name – types the name of the map. This name will be displayed later on in the game 
screens. By default, the scenario name is set to “Randomly Created Map”.

� Author – types the name of the author who creates the map. By default, the author is set 
to “UNKNOWN”.
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8.2.Description

You can enter a brief description of your map in this edit box. The description will appear as
part of the map information displayed in the game. By default there is no description.
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8.3. Settings

You change the default map settings with the help of this property sheet.
� Game Type drop down box – determines the types of the game (Standard or Not

Specified)
� Victory Condition - determines the condition for the player to win the game (Standard, 

Destroy Castle, Score Limit, Time Limit and Not Specified).
� Population Limit – determines the Population limit for each player.
� Difficulty Level – sets the difficulty level for the player (Easy, Normal, Hard)
� No Fog – if checked, there will not be any fog when playing this map.
� Explore – if checked, the map is revealed when the game is started.

9. Kingdom Properties

To edit the kingdom properties, use the command ‘Kingdoms…’ in the Map menu and open 
the Kingdom Properties dialog. This dialog contains five groups of kingdom properties. In 
each group you can edit specific types of properties for all eight kingdoms. This means that 
there are eight lines of controls.
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9.1. General

In this property page you can set some general player/kingdom properties.
� Kingdom column – changes the name of the kingdom.
� Tzar column - changes the name of the Tzar who rules the corresponding kingdom.
� Civilization column – changes the civilizations for the corresponding kingdom 

(European, Arabian, or Asian).
� Player Type column – changes the type of player (Human or AI, AI Only or Rescue).
� Active column – check if you want the player to be active in the game. Unchecked 

kingdoms/players will not appear when playing game.
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9.2. Resources

In this page you can define the initial resources for each kingdom. The resources are food, 
wood, gold and stone. There is a column for each resource with eight rows (for each 
player). The buttons on the right allows you to quickly operate the resource amounts.

� Fill Row buttons :
− Low – fills the row that is in focus with default values with a low amount of initial 

resources.
− Medium - fills the row that is in focus with default values with a medium amount of 

initial resources.
− High - fills the row that is in focus with default values with a high amount of initial 

resources.
� Equalize buttons - helps you to quickly equalize the kingdom’s resources.

− Column – makes the amounts in the column equal to the amount found in the edit box 
from the column in focus. For example: If you define 100 stones for Kingdom 1, then 
the Equalize Column will make all kingdoms have the equal amount of stones: 100. 

− Row – makes the amounts in the row equal to the amount found in the edit box from 
the row in focus. For example: If you define 200 stones for Kingdom 1, the Equalize 
Row will make all the food, wood and gold in the kingdom have the equal amount of 
200.

− All Columns – copies all values in the column that is in focus to all other columns.
− All Rows - copies all values in the row that is in focus to all other rows.
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9.3. AI

In this page you change the AI game settings for each player.
� Script drop list – choose script file from the list. The Editor allows you to add other 

scripts. You may also compose scripts of your own.

How to create and add a new script?

All script files are kept in the TZAR\DATA\AI folder. The script file extension is “ai”. The 
new script needs to be saved (for example “A_magic.ai”) in the same directory. Then you 
have to change the description in the “Ai.ini” file situated in the TZAR\DATA folder as 
follows:

[scripts]
Random = random.ais
Trade = E_trade.ai
Magic = A_magic.ai

‘Magic’ is the display name of the script. ‘A_magic.ai’ is the exact file name of the script that 
you have created. Save ai.ini in the TZAR\DATA folder, the script Magic is added in the 
Script combo box in the TZAR Map Editor.

� Economy AI – defines economy AI for the corresponding player.
� War AI - defines war AI for the corresponding player.
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9.4. Technology

This property page helps you configure certain restrictions for Upgrades and Researches, and 
prevent the player from building certain buildings and units. To set the technological level of 
each player/kingdom, first choose the desired player/kingdom form in the Kingdom column.
When the point (radio button) appears to the left of the kingdom’s name, you can set the 
technological level for this kingdom. Information about the civilization of the kingdom is 
displayed to the right of the kingdom’s name.

There are four different types of technology to configure. To select a technology type, use 
a group of radio buttons bordered with a Technology frame. When selecting technology, 
the list in the middle of the dialog will be filled with the skills found in each type.

� Prohibited Buildings – if you check any of the listed buildings, the selected 
player/kingdom will not be able to build them while playing this map.

� Prohibited Units – if you check any of the listed units, the selected player/kingdom will 
not be able to build them while playing this map.

� Initial Researches – if you check any of the listed researches, it will be discovered from 
the very beginning of the game

� Prohibited Researches - if you check any of the listed researches, the selected 
player/kingdom will not be able to use this research during the game. 
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� Prohibited Upgrades – if you check any of the listed upgrades, the selected 
player/kingdom will not be able to use this upgrade during the game.

9.5. Diplomacy

This property page is where you set the initial diplomacy status between two players.
Start by selecting a kingdom from the Kingdom combo box. If you want this kingdom to 
share a victory with others, check the Shared Victory check box. This means that if the 
player belongs to a team and achieves the Victory Condition(s), he wins the game for the 
whole team. You can also set the diplomacy status between a particular kingdom/player 
and all others. This is done with the help of the six buttons situated in the middle of the 
dialog. The first group of three buttons in each row is used for a general diplomacy setting

� Ally

- sets up an alliance between the selected kingdom and the kingdom listed in this row.
� Enemy

– makes enemies of the selected kingdom and the kingdom listed in this row.
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� Neutral

– creates a neutral status between the selected kingdom and the kingdom listed in this 
row.

The second group of three buttons is used for a detailed setting of Ally diplomacy. That is 
why these buttons are available only when Ally diplomacy has been set up between two 
kingdoms.

� Shared Vision 

– the selected player can see the discovered areas of the player found in the list.

� Shared Resources

– the selected player can use resources of the player found in the list.

� Command Units

– the selected player can command units that belong to the player found in the list.
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10. User Resources

You can import images, sounds and music into a map. These user resources are used in 
certain Actions (Show Story Screen, Show Message or Add Quest), Items (Scroll), but mostly 
in Conversations and Custom Sounds. These three types of user resources have three very 
similar dialog boxes. The only difference in these dialog boxes is how the resources are 
previewed. To open any of these three dialog boxes, use the commands (Images (*.bmp),
Sounds (*.wav) and Music (*.mid)) situated in the Map/User Resources menu. 
Each dialog box consists of:
� List Box – displays a list of imported images/sounds/music. You can select one of the 

items listed here to perform further operations.
� Click Pick to attach the selected user resource as a property. This button appears only 

when the dialog box was opened from another property sheet or dialog box.
� When in the pick mode (Pick button on), double click on the selected name in order to 

pick it.
� When in the normal mode (Pick button off), double click on the selected name and you 

will see this user’s resource (view image or listen to sound or music). 
� Close – returns you to the previous dialog without picking the user resource.
� Click Import to add a new user resource to the list.

Note: Images are bitmap (BMP) files. The best bitmaps are in Hi Color. Sounds are WAV 
files. The best sounds to import are 22 kHz, 16bit mono (or stereo for story screen). Other 
WAV files will not be performing with the best quality. Music is in MIDI files.
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� Delete – removes previously imported user resources.
� Export –saves the selected resource as a file. This option allows you to save the resource 

outside the map and use it later on in other maps.
� View – gives you a view of the selected image in the Import Images dialog.
� Play – lets you listen to the selected sound. Use Stop All (or Stop) to turn off the 

sound/music.

Note: If you import an image (bitmaps) with the name ‘Minimap.bmp’ (no case sensitive), 
you can choose this image to be used for the custom mini-map in the game, instead of those 
generated at runtime. This is achieved by using the command ‘Use Custom Mini-Map’ in the 
Map/User Resources menu. 

Note: If you import an image (bitmaps) with the name ‘Maptitle.bmp’ (no case sensitive), you 
can choose this image to be used for the custom map title image in the game instead of the 
default title image. This is achieved by using the command ‘Use Custom Title Image’ in the 
Map/User Resources menu.

11. Custom Sounds 

You can attach your own sounds to any object or point in the map. You define custom sounds 
with the help of the ‘Custom Sounds’ dialog box. To open this dialog box, use the Custom
Sounds… command in the Map menu.

Click the button New to create a new custom sound. A sound with a default name will be 
created. You can change this name in the Selected Sound field. To remove previously created 
custom sounds, use the Delete button. There are two groups of properties for each custom 
sound.
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11.1.Sound property page

� Pick – launches the Import Sounds dialog to pick sound from user resources.
� Clear – removes the sound previously picked.
� Play – click this button to listen to the selected sound. Use Stop to turn it off.
� Repeat group – with this group of controls you alter the way sound is played.

− Every - the sound will be repeated in an interval set in the edit box.
− Looped – the sound will be repeated infinitely without intervals.
− Random from – the sound will be played randomly at specific intervals. 
− Delayed start – the sound will be delayed. 
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11.2.Source property page 

In this page you set the source of the sound. The source can be a map location (point) or a 
map object. If the source is a map object, the sound moves when the object moves.

Map Point as the source of the sound: two fields with X and Y coordinates.

Map Object as the source of the sound: select object from the map here.

� Set – select the object from the map and click on Set. The name of the object is displayed 
in the text box.

� Clear – this will remove the sound from the selected object.
� View – click this button to center the set object in the main window.

12. Custom Music

You can select your own music to be background music while playing the game. The play 
order is in a random manner. To define your custom music use the Custom Music dialog
box. To open this dialog, use the Custom Music command in the Map menu.
To add music from user resources click on Add, to remove it click on Remove.

13. Map Rules, actions and events

In this map editor you define rules to determine unit behavior or special victory terms. With 
the help of rules, you can program your maps and create custom campaigns where the 
outcome has been determined beforehand. Each Rule consists of two parts. The first part is 
the Rule condition. The second part is a list of Rule actions. 
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Rule Condition is an expression that equals a value. (See13.1.3 to read more about 
expression.) In this expression, variables are not only constants and user-defined variable 
names, but also special variables called events. Event variables are automatically set by the 
game when something occurs. There are eight events in the game that the user can define. For 
example: The most used event is ‘Object In Area’. The variable for this event (the name of 
the variable is the name of the event) will be TRUE (nonzero) when a group of specified 
objects or objects of a specific type are in the specified map area. When they are in this 
specified area, the game automatically sets the event variable to TRUE. In all other cases the 
event variable will be FALSE (0). 

So, the Rule Condition is a combination of operators, functions (see 13.1.3), event variables, 
user-defined variables and constants. 

Each time the game checks the rules (all rules are checked about every second) the Condition
will be evaluated. If the result is nonzero, the game executes all actions from the list of rule 
actions. The order of execution follows the numerical order of the list (action on the top will 
be executed first, and action on the bottom of the list will be executed last). When the game 
executes certain rule actions, the Rule is no longer valid except when there is a ‘Keep Rule’
action in the list. All Rules that have a ‘Keep Rule’ action in their lists will be checked until 
the end of the game.

Actions consist of more than 20 operations that the user can command. For example: Actions 
are Object Order (set order to a specified object), Player Lose (forces one player to lose the 
game), Destroy Object (destroys specified objects) etc.

To define rules, actions and events use the Rules dialog box. To open this dialog, use the 
Rules… command in the Map menu.

The Rules dialog is divided into two parts. The first part is situated at the top of the dialog 
above the separation line. This part is for creating and editing Actions and Events. 
To show a list of the Actions, click on the radio button Actions. To show a list of the Events, 
click on the radio button Events. Underneath these two radio buttons, the list of actions and 
events is located. When you select an item from this list, a group of property pages will 
appear on the right-hand side. With the help of these property pages, you can edit all 
properties involved in a particular action or event. For complete information about actions, 
events and their properties, see 13.2.
To add a new Action/Event click on the button New, situated below the list of 
Actions/Events. The New Action (New Event) dialog box will appear. Select the desired item 
from the list, and edit a default name if you want. When you click on OK, the new Action 
(Event) will be activated in accordance with the selected type. The type of action is displayed 
above the text box with its name. You edit the name of the selected Action (Event) by typing 
the name in the edit box. To edit the Action (Event) properties, use the property pages. 

Note: An Event name may only contain letters, digits and underscores. An Action name may 
only contain letters, digits, spaces, underscores and apostrophes.

To edit the Rule properties, use the controls situated below the middle separation line.
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All rules in the game are listed in the Rules list box. To create a new rule click on the button 
New, situated below the rules list. To edit the Rule name, use the Rule Name edit box. A rule 
condition can be entered in the Condition for Rule text box. 
All actions for a selected rule are found in the Actions for Rule list box. To add actions to 
this list you have to be in Actions (actions are to be listed in the upper part of the Rules
dialog box). Click on Add. The selected action in the Actions list box will be added to the 
Actions for Rule list box. To remove an action from the Actions for Rule list, select the 
desired action in this list box and click on Remove.

Note: When an action is deleted from the Actions list (list box in the upper part of the Rules
dialog) it will automatically be removed from all ‘Actions for Rule’ lists.

To change the order of execution for rule actions, use the Up and Down buttons on the left 
side of the Actions for Rule list box. Just select the item and click on the up or down arrow 
buttons to move it in the list.

Note: Actions for given rules are executed in the order defined in this list box. The action at 
the top will be executed first, and the action at the bottom will be executed last.

13.1. General Actions and Events property pages.
This section will describe certain property pages which are property pages for more than one 
action or event type. Later on, when all actions and events have been described, you will see 
frequent references to this section, so read it carefully.

13.1.1.Object properties page: Here you edit properties for objects. 
An Object property is a frequently used property for actions or events. There are two different 
kinds of Object properties: Either a set of objects, or a type of object. 

� Set of objects: Here you define a set of objects that already exists in the map. To add an 
object to this set, select the object in the main window and click on Set. To remove an 
object, select the object name in the list-box of objects and click on Clear. You can add or 
clear more than one object in one operation. To view objects that have a focus caret, click 
on View.
Options from the ‘For which’ group are used to define how the action or event properties 
are applied to the selected objects. For example: You create an ‘Object in Area event’ 
which has two property pages – Object and Area. In Object you select to use 10 
peasants. Then you need to define the area properties for this event. If All is checked, the 
event will proceed only when all of the selected objects are in the defined area. If Any is
checked, the event will take place when any of the selected objects appear in this area.

� Type of objects: Here you select type of objects, kingdom(s) and object count. The 
counting method is also set here: All objects or Any object.

Type drop-down box: Select the object type.
− Player – select the owner of the object(s). More than one player can be checked. 

Check All and Clear All easily checks/clears all players. 
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− Count - enter the amount of objects you wish to have. You can choose the 
comparison operation between  ‘>=’ or ‘<=’. In some actions, no count property will 
be available.

� Holder properties page: This property page is available only in the ‘Leave Holder’ and 
the ‘Enter Holder’ event. It is used instead of the Set of objects property page to limit the 
content of a set to only one object
− Set – select the object from the map and click on Set. The name of the object is 

displayed in the text box.
− Clear – removes the sound of the property
− View – click this button to center object in the main window.

13.1.2. Area property page: Here you edit the areas. An area can be a rectangle or a map object. 
� Rectangle: Here you see the top-left and the bottom-right coordinates for the rectangle. 

You edit the rectangle by using the mouse in a drag and drop manner.
− Edit – when this button is pushed, you can edit the dimension and the position of the 

rectangle. Click and drag on a location to re-position it, or click and drag any of the 
corners or side hotspots at the edges to resize it.

Note: Location can only be edited when the Edit button is on.

− View – click this button to center location in the main window. Location is displayed 
as a rectangle filled with 50% black transparency.

− Move – when you click this button, the rectangle move to the center of the main 
window.

� Object: This is the case-area position of the object at the current time. 
-      Set – select the object from the map and click on Set. The name of the object is 

displayed in the text box in the Map Object edit box.
− Clear – removes the sound of the property.
− View – click this button to center object in the main window.

13.1.3. Expression property page: This is the property page where you can write different 
expressions. An expression is any combination of variables, operators, constants, functions and 
names of fields and properties that equals a number.

Operations are:
� && The logical-AND operator produces the value 1 if both operands have nonzero 

values. If either operand is equal to 0, the result is 0. If the first operand of a logical-AND
operation is equal to 0, the second operand is not evaluated. 

� || The logical-OR operator performs an inclusive-OR operation on its operands. The result
is 0 if both operands have 0 values. If either operand has a nonzero value, the result is 1. If 
the first operand of a logical-OR operation has a nonzero value, the second operand is not 
evaluated.

� <, <=, >, >=, ==, != - Relational and Equality Operators. The binary relational and 
equality operators compare their first operand to their second operand, in order to test the 
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validity of the specified relationship. The result of a relational expression is 1, if the tested 
relationship is true, and 0 if it is false.

� + Addition Operator. The addition operator (+) causes its two operands to be added.
� - Subtraction Operator. The subtraction operator (-) subtracts the second operand from the 

first.
� * - Multiplication Operator. The multiplication operator (*) causes its two operands to be 

multiplied.
� / - Division Operator. The division operator (/) causes the first operand to be divided by 

the second.
� ! - Logical-NOT Operator. The logical-negation (logical-NOT) operator produces the 

value 0 if its operand is true (nonzero) and the value 1 if its operand is false (0).
� % - Modulus Operator. The result of the modulus operator (%) is the remainder when the 

first operand is divided by the second.
� = Assignment operator. An assignment operation assigns the value of the right-hand

operand to the storage location named by the left-hand operand.

You can use parentheses to change the priority of a calculation order. Enclose any operand in 
the parentheses. Operands can also be integer constants.
Operands can be internal reserved variables:

$health – health of the current object
$maxhealth - max health of the current object
$attack – attack of the current object 
$defense – defense of the current object 
$level - level of experience of the current object 
$manna – manna of the current object 
$maxmanna – max manna of the current object 
$kingdom – current player kingdom
$x - position x
$y - position y
$gold - current player’s gold reserve
$stone - current player’s stone reserve
$food - current player’s food reserve
$wood - current player‘s wood reserve

Operands can be your own defined variables. Just insert ‘$’ to the left of the custom name 
of the variable: $NAME. Note that ‘NAME ‘ cannot be identical to a reserved internal 
variable.

Operands can have certain functions:
@gold (Player) – gets gold for the player. The player is operand for this function – must 
be from 1 to 8.
@stone (Player) – gets stone for the player. The player is operand for this function –
must be from 1 to 8.
@food (Player) – gets food for the player. The player is operand for this function – must 
be from 1 to 8.
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@wood (Player) – gets wood for the player. The player is operand for this function –
must be from 1 to 8.
@rnd (Number 1, Number 2) – this function gets a random value between number 1 and 
number 2. Number 1 and number 2 are operands for this function.

Examples for expressions:
(5*3 – 8)/12*7 >= ($My_VAR2/10 + 5)
or
@gold (2) == $stone + 100
or
$My_VAR1 = (5*3 – 8)/12*7 
or
$My_VAR1 = $gold + 100 
or
$My_VAR2 = 3 + $health
or
$My_VAR1 = 2*$My_VAR1 – ($My_VAR2/10 + 5)
or
@gold ($My_VAR1)
or
$My_VAR1 = rnd ($My_VAR1, 4*$My_VAR1) 
or
$My_VAR2 = @stone + 100

13.1.4. Players’ property page: Here you set one or more players. The Check All and Clear All
buttons easily checks/clears all players.

13.1.5. Text property page: In this property page you edit texts.

13.1.6. Image property page: Here you can edit an image that is a property for certain actions. 
Click on Pick to pick an image from the user resources. You clear the picked image with the 
Clear button. Click on View to preview the image.

13.1.7. Sound property page: Here you can edit a sound that is a property for certain actions. 
Click on Pick to pick a sound from the user resources. You clear the picked sound with the Clear
button. Click on Play to listen to the sound you have picked, and Stop to turn the sound off.

13.1.8. Music property: In this property page you can edit music that is a property for certain 
actions. Click on Pick to pick music from the user resources. You clear the picked music with the 
Clear button. Click on Play to listen to the music you have picked, and Stop to turn the music 
off.

13.1.9. Map property page: Here you edit the map name for the next map in the campaign. This 
property is used in the ‘Player Win’ and the ‘Player Lose’ actions that forces the map to end.
Type the main name (without extension) in the edit box, or use Pick to browse the maps on your 
disk and get a name from them.
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13.2. Actions
In this chapter we will describe all Actions available in the game. The specific properties of 
each action will also be described.

13.2.1 Add Quest action: This action adds a quest to the quest list in the game. Quests consist of 
text and an image. The name of the quest is the name of the action. This action has two property 
pages:
� Text property page (see 10.)
� Image property page (see 10.)

13.2.2. Remove Quest action: This action removes a previously added quest with the Add Quest
action. This action has one property page:
� Quest properties page – select the quest to be removed from the combo box.

13.2.3. Appear Object action: With this action you can make objects appear that have the Not
Appear flag. After the action is executed, the objects will appear in the map. This action has one 
property page:
� Object property page (see 13.1.1.)

13.2.4. Change Diplomacy Settings action: This action allows you to change the diplomacy 
settings during the game. This action has two property pages:
� Kingdom property page –select two kingdoms for which a new diplomacy will be set. 
� Diplomacy property page – two groups with three buttons. For more details on these 

buttons (see 9.5.)

13.2.5. Change Object Owner action: With this action you can change the owner of object(s). 
This action have two property pages: 
� Object property page (see 13.1.1.)
� Kingdom properties page – in this page you select the new owner.

13.2.6. Change Player Status action: With this action you can prohibit a player from winning or 
losing, or allow him to win or lose. This action has one property page:
� Status properties page – select the kingdom/player whose status will be changed. 

Check/Uncheck one of two options: Kingdom cannot win or Kingdom cannot lose.

13.2.7. Conversation action: With this action you can start a conversation defined in the 
Conversations dialog. This action has one property page:
� Conversation properties page – select to start a conversation from the combo box.

13.2.8. Destroy Object action: With this action you can destroy one or more objects. This action 
has one property page:
� Object property page (see 13.1.1.)

13.2.9. Erase Object action: Same as the Destroy object action, but the objects disappear 
immediately without death animation.
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13.2.10. Explore Area action: With this action you can explore a map area for a specified time. 
This action has two property pages:
� General property page – time can be set and a Reveal Fog option can be specified. 

Note: Time is in milliseconds.

� Area property page (see 13.1.2)

13.2.11.  Expression action: With this action you can execute expressions. This action has one
property page:
� Expression property page (see 13.1.3) 

13.2.12. Keep Rule action: With this action you can keep Rule checked for the duration of the 
game. All rules that have this action will be valid until the end of the game. No properties for this 
action.

13.2.13. Load Map action: Use this action in a campaign when you want to go to the next map. 
This action has one property:

• Map property page (see 8.) 

13.2.14. Lock View action: This action freezes the view in a defined area for a specified time. 
You cannot scroll in the defined area.
� Time properties page - define the time interval in milliseconds.
� Area properties page - define the area (see 13.1.2.)

13.2.15. Lock/Unlock Units: With this action you lock/unlock units. This means that the player 
cannot command locked units until they have been unlocked. This action has two property pages:
� Object property page (see 13.1.1.)
� Lock/Unlock properties page – sets unit to be locked or unlocked.

13.2.16. Object Order action: With this action you give orders to unit(s). The order will be 
executed in a specified area. This action has three property pages:
� Object properties page (see 13.1.1.)
� Area properties page (see 13.1.2.)
� Order properties page – select a desired order from the combo box

13.2.17. Player Lose action: With this action you can force players to lose the game. After that 
the next map is loaded. This action has two property pages:
� Players’ property page (see 13.1.4.)
� Map property page (see 13.1.9.)

13.2.18.  Player Win action: With this action you can force players to win the game. After that 
the next map is loaded. This action has two property pages:
� Players’ property page (see 13.1.4.)
� Map property page (see 13.1.9.)
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13.2.19. Scroll View action: This action moves the view from the center of one map area to the 
center of another map area. 
� Area properties page /first one/ – starting area (see 13.1.2.)
� Area properties page /second one/ – ending area (see 13.1.2.)

13.2.20. Send Chat Message action: This action sends a message to the selected player/s.
� Players’ property page – select the player/s to receive this message (see 13.1.4.)
� Message – type custom message here

13.2.21. Set Object Properties action: This action is used to set the properties of the selected 
object/s. Properties can be set with Expression using internal reserved variables. This action has 
two property pages:
� Object property page (see 13.1.1)
� Expression properties page (see 13.1.3)

13.2.22.  Set Timer action: This action starts a timer that counts time in milliseconds. The current
time is stored as a variable and has the same name as the action name. You can check the variable 
in expression/condition to see the time. One property page:
� Timer properties page – enter an initial value for the timer in the Variable edit box. You 

can use the count-down option if you prefer.

Note: The variable value can be an expression.

13.2.23.  Show Message action: This action is used to make a message pop up.
� Title of message – the text that appears beneath the displayed picture.
� Text property page – type message text here
� Image property page – pick the image that will appear next to the message (see 10.)

13.2.24. Show Story Screen action: This action is used to activate a screen where you can read a 
story. You can see an image and listen to sounds and music. The text scrolls for a specified time. 
This action has five property pages:
� Time property page – enter the text scroll time. If you check Auto Close the story will 

automatically end when time elapses.

Note: Time is in milliseconds.

� Text property – enter story text here.
� Image property page – image for story (see 10.)
� Sound property page – sound for story (see 11.1)
� Music property page – background music for story (see 12.)

13.2.25.  Spawn Object action: This action will create an object in the map area specified on the 
map of a selected kingdom.
� Object property page - select type of object from the combo box. Select the owner of the 

object, and how many objects to create (number, not expression).
� Area properties page – the area where the object will appear (see 13.1.2.)
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13.2.26. Stop Timer action: Use this action to stop time measurement in the previously executed 
Set Timer action. One property page:
� Timer properties page – select timer to stop from the combo box.

13.2.27. Unlock View action: Use this action to unlock view if it was locked with the Lock View
action.

13.3. Events
In this chapter we will describe all Events available in the game, as well as their specific 
properties. When we indicate that an Event occurs, we mean that the value of the event is 
TRUE.

13.3.1. Object in Area event: This event occurs when certain map objects are located in a specific 
area. This event has two property pages.
� Object property page (see 13.1.1.)
� Area property page (see 13.1.2.)

13.3.2. Object Destroyed event: This event occurs when certain map objects are destroyed or 
killed. This event has one property page.
� Object property page – select the object/s (see 13.1.1.)

13.3.3. Objects Enter Holder event: This event occurs when certain map objects enter another 
map object that is a holder. Holder objects are objects which hold or accommodate other objects. 
For example: A Peasant is a holder when he carries an Item. The holder can also be a Tavern
since it can accommodate Units. Holder objects are Flying Carpets, Camel Traders, Ships etc.
� Object property page (see 13.1.1.)
� Holder property page – a special variant of the Object property page (see 13.1.1.)

13.3.4. Object Leave Holder event: Same as the Object Enter Holder but the event occurs when 
they leave the holder.

13.3.5. Object Exist event: This event occurs when objects exist (or are alive). 
� Object property page (see 13.1.1.)

13.3.6. Player Defeated event: This event occurs when a player loses the game. The player is the 
property of the event.
� Players’ property page (see 13.1.4.)

13.3.7. Player Won event: This event occurs when a player wins the game. The player is the 
property or the event.
� Players’ property page – select the player/s (see 13.1.4.)

13.3.8. Object Expression event: This event occurs when an expression is executed for given 
objects. This means that the event occurs when one or more properties of the objects are changed.
� Object property page (see 13.1.1.)
� Expression property page (see 13.1.3.)
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14. Conversations

The “real-life conversation” consists of a set of phrases expressed by one, two or more 
people. In the game, the conversations are very similar to real-life situations. The 
difference is that the participants of the conversation are not people. The participants in 
the game conversations are units, and the player rules over the conversations. He chooses 
which phrase to use if there are several phrases to choose from .The conversations appear 
in the game as boxes with text and a picture of the speaking unit. [img.41e]. Each 
conversation can have more than one initial phrase. The initial phrase can be comprised of 
up to six phrases. Each phrase has up to six follow-up phrases. Apart from words, the 
phrases can also have sounds.

You can create as many conversations as you like in one map. Each conversation is 
completely independent of the next. The phrases in one conversation cannot be used in 
another. The number of phrases in one conversation is unlimited. Each phrase can be a 
follow-up of other phrases. In this way you can create a conversation tree, in which the 
nodes are phrases and the connection between nodes are follow-up relations between 
phrases. You can do loops (one phrase follows-up itself) but this is not recommendable 
because the game will cycle in an endless loop. When a conversation starts, the game 
stops and you can only work with the Phrases dialog boxes. 
To create and edit conversations, use the Conversations dialog. To open this dialog, click 
on the Conversations… command in the Map menu. To create a new conversation, click 
on the button New situated to the left of the Conversation combo box. A small dialog, 
New Conversation, will appear. You can choose a conversation name in this dialog. A 
new conversation with a pre-selected name will appear in the Conversation combo box. 
To rename the conversation, click on Rename. To remove a conversation from the map, 
click on Delete. All three buttons (New, Delete and Rename) and the Conversation
combo box are situated at the top of the dialog, above the separation line. 
.
To edit selected conversation properties, use the controls situated below the separation 
line. The Phrases list-box contain all the phrases in this conversation. 
To create a new phrase, click on New below the Phrases list-box. Click on Delete to
remove a selected phrase. To change a phrase name, type a new name in the Selected
Phrase box. To set a phrase to initiate (start) a conversation, click the check-box to the 
left of phrase name. Any given conversation may use up to six phrases initially.

Note: Up to six phrases can be used to initiate a conversation.

To the left of the Phrases list box, properties for the currently selected phrase are located. 
Each phrase has four groups of properties. 

General property page:
� Source – you can set an object to say this phrase. Select the object in the main window 

and click on Set. To clear the object, use the Clear button. If you would like to view the 
object that says the phrase, click on View and the object will be centered in the main 
window.
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� Condition text box – type the expression, which must be a true one, before the phrase is 
said. Any kind of expression will work (see 13.1.3.) When the result of the expression is 
TRUE (nonzero), the phrase will appear. 

� Result text box – type the result when this phrase has been said. The result can be any 
kind of expression. It has an immediate reflection on the game. 

For example:
Condition:  $MyVAR <= 3, checks if the ‘MyVar’ variable value is less than 3. If this 
expression is TRUE, the phrase will appear and the expression in the Result box will be 
executed.
Result: $MyVAR = $MyVar + 1, when executed a new value is assigned to the ‘MyVAR’ 
variable.

Text property page:
Type the phrase text in this page. The text must not exceed 1,000 characters.

Icon & Sound property page:
� It is possible to pick a custom icon for the unit that says the phrase. An icon is selected 

from the Image user resources. You clear the icon of your choice (cause to use the default 
unit icon) with the button Clear, and view icons with the button View.

� You can pick a sound to play while the phrase text is displayed. Click on Pick. To listen 
to the sound you selected, click on Play. Click on Stop to turn the sound off. The Clear
button removes the sound completely.

Follow-up property page:
Set follow-up phrases for the current phrase here. The follow-up phrases are listed in the 
Phrases list box. To add new follow-up phrases, click on Add. A dialog box with the phrases 
available for follow-up will appear. Select a phrase from a list in this dialog box and click on 
Pick. When you select a phrase in the Phrases list box, a phrase text will appear to the right. 
You can read it and edit it. To remove a phrase from the follow-up list, select it and click on 
Remove.

Note: Each phrase can have up to six follow-ups.

How to start a conversation using Rules and the action ‘Conversation’?
Go to the Rules dialog. Create a new action ‘Conversation’. Name this action Conv1. In the 
drop-down list box that is situated in the property page for this action, select the existing 
conversation (if this list is empty, you should first create a conversation and then return to the 
Rules dialog). Now create a New Rule. Add Conv1 to the Actions for Rule list. You can type 
any condition in the Condition for Rule box (see 13.) When it becomes true, the action will be 
executed and the conversation will start.
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15. Creating Campaigns

One campaign consists of maps which appear in a defined order. The order is defined from the 
map. Actions: Load Map, Player Win and Player Lose. To read more about these actions, see 
sections 13.2.13, 13.2.17 and 13.2.18. The campaign is a file that contains map files and some 
additional information about the campaign. To create your own campaigns, launch the TZAR 
Campaign Editor (TzarCampaign.exe) situated in your TZAR folder. The campaign editor is a 
very simple application. In the main window you will find two property pages. The first property 
page contains a list of all campaign maps. By clicking on Import, you can add maps to the 
campaign. To export a map that is already in the campaign, select the map and click on Export.
To remove a map from the campaign, select the map and click on Delete.
To see more information about each map, select a map and click on Description (see 8.2. for 
more information). Click on Details to see specific map details. To set a map to start the 
campaign, check the box on the left-hand side of the map name. You can set more than one map 
to be the starting map. If there is no starting map, the campaign is not valid. You can enter a 
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detailed description for the campaign on the description page. This text will appear in the game 
campaign screen when you select this campaign to be played. Use the Save command in the File
menu to save your campaign, or use the corresponding button in the Tool Bar. 

Note: If you want campaigns to be available for the game, save (or place) them in your 
TZAR\CAMPAIGN folder.

Use the Open command in the File menu to open an existing campaign, or use the corresponding 
button in the Tool Bar. If you were in the process of editing another campaign, you will be given 
the option to save that campaign before opening the new one.

To create a new campaign, use the New command in the File menu.

TZAR: The Burden of the Crown ™ is a trademark of Infinite Loop© 1999 which is a registered trademark of 
PAN Interactive Publishing ®1999, TZAR: The Burden of the Crown ™ is developed by Haemimont
Multimedia ® Sophia Bulgaria. All Rights Reserved. 


